Release Note for BrailleSense 3.0

New Functions

1. New Menu Structure.
a. Menus have been re-organized to hopefully, offer a more sensible arrangement, and greater room for growth. While we know this may make things a bit more difficult initially, we do believe it will be more efficient in the long run.
b. We ask you to remember that there are global hotkeys for opening each BrailleSense application, and these have not changed. So, if you are used to pressing F1, then N to open Notepad, remember that pressing "F1-N" together will get you the same result.
c. All items aside from File Manager are now contained in a menu.
d. New "Office Tools" menu contains Word Processor, Notepad, e-mail, and Excel Viewer.
e. Video Search is now permanently available in the “Media” menu rather than having to be installed as an add-on.
f. Sense Dictionary has been moved to the "Library" Menu.
g. The New web Browser is now installed in the full firmware at the top of the “Web Tools” menu. The original web Browser is available further down in the menu as we transition to the new browser, but will eventually be phased out.
h. Color Reader has been removed from "Extras", and new Braille Practice application has been added. (See number 4 below)
i. "Clock and Timer" menu has been created containing Set Time and Date, Display Time and Date, World Clock, Wake Up Alarm, Stopwatch, and Sleep Timer.
j. Global Options has been divided into 3 options dialogs in the "Settings" menu, "Braille Options", "Voice Options", and "General Options". The Braille Learning Table setting is now a separate dialog in the Settings menu.
k. New "Help and Information" menu now contains Quick Start Guide, User Guide, Latest Release Note, View Device Name, and Device Information. 
l. Play Store has now been moved to the top of the "Android Apps" menu.
m. A "Favorite Apps" menu has been added to the bottom of the main menu.
i. This function allows you to create a personalized list of the apps you use most often, including 3rd party Android apps.
ii. To add or remove items from your Favorite Apps, use the associated new buttons in the Menu Manager. 
iii. In addition to bringing up this list from the Main Menu, you can also call it from anywhere on the unit using "Control-F1"
iv. Favorite Apps is a list, rather than a traditional menu, thus, you can use first letter navigation.
2. New/updated Word Processor
a. Updated Word Processor engine for general stability and improvements.
b. Added the ability to insert footnotes. Press “Backspace-Space-Enter-E” or choose the option from the “Insert” menu.
c. Bullets and numbering can now be created. 
i. Activate with “Backspace-Space-Enter-B” or from the Layout menu. Tab forward in the dialog to choose the bullet or numbering type.
ii. Adjust the outline level while editing using Control-Dot-3 and alt-Dot-6.
d. You can now insert a table using Control-Alt-T. Press “Control-Alt-D” to delete a table.
e. Cell position is now announced when you move within a table or query the Cursor Position.
f. Added an option to determine whether table information is announced in the “Settings” dialog in the “File” menu.
g. The following table movement commands have been added:
i. Move to previous table: Control-Alt-dots-3-4-5-6.
ii. Move to next table: Control-Alt-dots-1-4-5-6.
iii. Move up one cell in the Table: Control-Alt-dot 1.
iv. Move down one cell in the Table: Control-Alt-dot 4.
v. Move left one cell in the Table: Control-Alt-dot 3.
vi. Move right one cell in the Table: Control-Alt-dot 6.
vii. Move to first cell in the Table: Control-Alt-dots-1-2-3.
viii. Move to last cell in the Table: Control-Alt-dots-4-5-6.
ix. Move to first cell in row: Control-Alt-dots-1-3.
x. Move to last cell in row: Control-Alt-dots-4-6.
h. You can now adjust font size using Control-dot-2 and Alt-dot-5.
i. You can now export directly to TXT as well as BRF using the “Export” option in the “file” menu.
j. Added the ability to bring up a list of marks. Press “Backspace-L”, or choose “Mark list” from the “Mark” menu.
k. Items beginning with HTTP:// are now recognized as hyperlinks. You can also now use “Control-L” to open a hyperlink in the BrailleSense native browser, and “Alt-L” to open a hyperlink using the default Android browser.
l. Added the ability to view style, font and formatting info for the current paragraph. Press “backspace-Enter-Y” or choose the option from the “read” menu.
m. There is now a “set as default” option in the Paragraph Layout dialog, so that you can choose universal options that will apply unless you make modifications for selected text.
n. Added the “set Current As Default” option to the “Document Layout’ dialog.
o. The line spacing option is now a list box, with standard line numbering options.
3. New Web Browser
a. Offers a BrailleSense interface with the abilities of a modern browser like Edge or Chrome.
b. Located at the top of the Web Tools menu,  the original Web Browser is still included for now near the bottom of the menu.
c. While we believe this browser is stable and capable enough for release, with the endless amount of website variation, we expect to continue to improve the new Browser, thus, it will remain updatable via the Add-Ons menu without a full firmware upgrade.
d. Note: the first time you open the web browser, you are asked to accept permissions similar to those you see in native Android applications, as the new web Browser seamlessly integrates the Mobile Screen Reader for some of the more modern functionality.
e. Keystrokes have been stream-lined for better usability, please use "Space-H" to get a current list.
f. All settings that offer Browser selection, such as in Google Search and e-mail now include a Browser V2 option. You may also set the default browser for opening URL'S with "Space-W" in the "General Options".
4. Braille Practice application
a. Located at the top of the Extras menu.
b. Provides general practice for letters, signs and punctuation, numbers, contractions, and various levels of vocabulary words.
c. Punctuation, numbers and contractions offer uncontracted Braille renderings for clarification.
d. Word practice prompts are speech only, and allow for practice at individual contracted Braille learning levels, as correctness is based on spelling.
e. You are given 3 chances to answer correctly before the application counts it as a wrong answer, and shows you the correct one.

Fixes and Enhancements
1. General 
a. Reduces the frequency of the device rebooting 3 times on a restart.
b. Updates all apps in the “Optional Add-ons” area to ensure compatibility with the current firmware. Please update your installation of available add-ons by pressing “Enter” on an item in the list.
c. Updates all apps in the App Installer to their current versions. Press “Enter” on an app in the list to update your current installation.
d. Adds Yuri and Catya Russian TTS voices
e. Adds "Dutch" and “Mongolian” braille codes. 
f. Fixes a problem translating combinations like FT60.
g. Fixes the problem of settings values not displaying correctly in Global Options on the MINI when Control Information is turned off.
h. Changes several settings dialogs to Tab order for efficiency.
2. File manager
fixes a problem renaming files if capitalization is changed.
3. Word Processor fixes
a. Change the “subscript” to “superscript and subscript” in the font dialog.
b. Inserted the “set footer and upper left/middle/right” and “set header and lower left/middle/right” option in the document layout dialog.
c. Fixed problems not showing the whole word count in the Cursor Position information.
d. Fixed problems incorrectly displaying revision content.
e. Fixed problems with text searches.
f. Added the “From Cursor to End” option in “Find and Replace”.
g. Fixed the problem of not getting image descriptions in slide files.
h. Fixed cursor key navigation in PowerPoint files.
i. Fixed problems opening Word, PowerPoint and Excel files reported by users.
j. Fixed the display and announcement of bullets.
4. Notepad
a. Improves recognition of PDF’s so that the OCR engine is activated for files with both text and images.
b. Adds compressed Mode for reading Braille files without gaps related to the Braille formatting and the shorter Braille display length.
i. Hotkey for toggling Compressed Mode on/off: Space-1-2-4-6. This was the hotkey used in the U2, so is likely to be familiar for those who used it extensively before. 
c. Adds the Mark List function for the current session. Hot-key is backspace-M.
d. Fixes a problem restarting the Notepad after the language is changed.
5. Email
a. Fixes a problem moving messages to trash using the “Move to Mailbox” function.
6. Excel Viewer
a. You can now open links in the Android browser with Backspace-L, as well as the HIMS default browser with Enter-H.
b. Fixes issues opening some Excel files.
7. Media Player
a. Fixes problems recognizing some chapter formats in MP3 files.
b. Changes the Chapter list command to “Enter-L” for consistency with Podcasts.
8. Podcasts
a. Removes GPodder and the Digital Podcast directories in favor of a new Podcast Index Search powered by Chat GPT, with more relevant results, and descriptions for all podcasts.
b. Updates Default Podcast list.
c. Fixes problems downloading episodes of the Eyes On Success podcast.
d. Fixes a problem where podcast playback would crash after a few minutes when played in the background.
e. Adds progress indication when an OPML is being imported.
f. Fixes the display of elapsed playback time in the MINI.
9. Web Radio
a. Changes interface to be more like the SensePlayer:
i. Program opens in the Channel list, and only Channel controls appear in the dialog.
ii. Search and Update Database functions are now located in the menu.
iii. During playback, you can now tune through stations using Dot-3 and Dot-6. Press F4 to stop playback and return to Channel list.
b. Updates the default Channel List to fix BBC streams, add missing ACB and NFB streams, and replace channels that are no longer available.
10. DAISY Player
a. Added a hint when opening a DAISY book to press Space on a folder then Enter to open.
b. Added “Recent Books” function for opening a list of books you’ve recently been reading. Hot key is “Backspace-Enter-H”. Press “Enter” on focused title to re-open it.
11. Address Manager
a. Adds a Sort Option so that you can choose to sort by either first or last name. Find it in the menu, or use “Backspace-S”.
b. Adds an option in the menu to Set Fields for saving. This allows you to choose to save only certain fields when exporting to a file. Hot key is “Backspace-V”.
c. Fixes a problem where, when embossing an address list, the Braille Document Layout options were not honored.
d. Fixes a problem where fields were duplicated on saving to a file.
e. Changes the location of the Zip Code field to be more sensible.
12. Database Manager
a. Adds the ability to pick a random item from a database in the Database Manager by user request. The hot key is Backspace-Enter-R.
13. Original Web Browser
a. Fixes a problem of MP3'S not giving you the option to download or play.
b. Fixes a problem where HTML files could not be opened after being copied to external memory.
14. Sense Dictionary
a. Fixes a problem where search results did not appear when calling the sense Dictionary edit box.
15. General Options
a. Adds an option to adjust headphone volume above the master volume for headphones with lower output levels.
b. Adds an option to determine whether the numeric indexing is reported.
c. Adds an option to determine whether pressing a menu item’s shortcut automatically opens the menu, or just places focus on it.
d. Adds an option to choose the default Browser used when opening a URL with Space-W, etc.
16. Menu Manager
a. Fixes the problem where chat GPT disappeared from the Menu Manager once it was hidden, thus making it impossible to restore.
b. The interface has been changed so that, for both hiding applications and adding to favorites, you must activate the associated button after selecting programs.
c. This means, if you wish to hide programs, Pressing "Enter" after selection will no longer perform this action, but rather, you must press "Enter" on the "Hide Selected Apps" button.
17. Backup and Restore Settings
a. Fixes the problem of not backing up and restoring “calendar to add appointment in the To Do list.
18. Language Profiles
a. Fixes the problem of locking up when using an Android voice in a language profile.

